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Overview of What's New

What's New in Autodesk Maya
Welcome to What’s New in Autodesk® Maya® 2011.

Maya 2011 features a powerful new set of tools for creating and re-purposing
character animation. With an updated interface that helps artists be more
efficient, and a new 64-bit offering for Mac OS® X, Maya 2011 is more accessible.
In addition, Maya 2011 addresses production pipeline challenges, with an
accelerated viewport display for large scenes; a completely new UI toolkit; and
new solutions for 3D editorial, color management, scene segmentation, and
rotoscoping.

Refer to the following sections for details on all the new features in Maya 2011.

General and Performance

New to Maya 2011 is a fresh customizable interface
with many enhanced windows and editors. Assets and
File Referencing are enhanced to help modularize your
scenes. Finally, Maya 2011 features a number of per-
formance enhancements to improve your overall ex-
perience.
■ What's New in General on page 7

■ What's New in Performance on page 15
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Modeling

Maya 2011 provides a number of modeling features
to streamline your workflow. Bezier curves are now
available so you can adjust curvature on the fly. In
polygon modeling, you can now connect arbitrary
components on a polygon mesh and spin edges along
their midpoint to quickly change the topology of your
mesh. Additional features such as object level soft se-
lection and invisible faces give you more options for
interacting with your models.
■ What's New in Modeling on page 17

Animation

Accelerate pre-visualization with new 3D editorial
features. The new Camera Sequencer lets you import
and export editorial content (including movie, audio,
and timecode information), layout and manage camera
shots in a sequence, and playblast movie footage for
playback and review. Other enhancements for anim-
ators include multiple audio track support, scene
timecode options with heads-up display, improved
global timewarping effects, and several Graph Editor
improvements that make it easier to view, select, and
edit animation data.
■ What's New in Animation on page 21

Rigging

Create characters with realistic skin deformation in
less time with new skinning tools and workflows: in-
teractive skin binding, dual quaternion smooth skin-
ning, enhancements to the Paint Skin Weights Tool,
and improved weight normalization.
In addition, an improved non-destructive animation
retargeting workflow lets you easily reuse, correct, and
enhance your character animation. Based on the
Autodesk® HumanIK® libraries and animation layers,
you can easily transfer animation and adjust retarget-
ing parameters live, without baking to see results.
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You’ll also find new Point on Poly and Closest Point
constraints, new weight mirroring support for the
blend shape, cluster, jiggle, and wire deformers, and
several other deformer improvements.
■ What's New in Rigging on page 27

Paint Effects

Add phototropic effects to painted flowers and leaves
using new Flower Face Sun, Leaf Face Sun, and Sun
Direction attributes. Maya 2011 also offers a new
Transfer All Strokes to new Object option that simpli-
fies transfers of paint strokes from low to high resolu-
tion meshes.
■ What's New in Paint Effects on page 33

Dynamics

Improvements to the Dynamic Relationship Editor let
you view, create, and edit connections between mul-
tiple dynamics objects.
■ What's New in Dynamics on page 35
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Fluid Effects

Several new Fluid Effects features enhance the realism
of your fluid simulations. In Maya 2011, an Auto Res-
ize option automatically resizes 2D and 3D fluid con-
tainers, reducing simulation and batch render time.
Improved internal lighting features let you preview
lighting and shadow effects in the scene view before
rendering your fluid effect.
New fluid emission methods give you more control
over how fluid is emitted into containers, including
options for mapping emitted fluid to 2D textures.
Additional fluid container property options, fluid
solver enhancements, and new fluid behavior attrib-
utes are also included.
■ What's New in Fluid Effects on page 37

nCloth

Maya 2011 includes a Collide Strength attribute for
controlling the force of nCloth collisions as well as
paintable Rest Length Scale, which lets you easily cre-
ate ruffles and flares in simulated clothing. A new
option for nCaching improves results when simulating
off the end of nCaches.
■ What's New in nCloth on page 47

nParticles

In Maya 2011, you'll find a number of new per-particle
attributes, including Rotation, Friction, Bounce and
Stickiness. Create more realistic liquid simulations
with new Surface Tension and Viscosity Scale attrib-
utes. Maya 2011 also has enhanced nParticle output
mesh features, with per-vertex shading and velocity,
as well as improvements to mesh quality and perform-
ance.
■ What's New in nParticles on page 49
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Rendering and Render Setup

New to Maya 2011 is the Viewport 2.0 that provides
large scene performance optimization. The Hypershade
has also been redesigned to allow for easier and faster
render node creation. The new pan/zoom feature al-
lows you to pan and zoom in 2D and the color man-
agement feature allows you to control the color profile
associated with inputs to and outputs from rendering.
You can even use color management on 32-bit floating
point HDR images in the Render View. Other features
include the multi-camera rig tool for stereoscopic
cameras and new ambient occlusion pass attributes.
■ What's New in Rendering and Render Setup on page 55

MEL and Python

PyMEL is now installed with Maya. New MEL and Py-
thon commands have been added, and new flags ad-
ded to existing commands.
■ What's New in MEL and Python on page 61

Documentation

The Maya Help now features a static navigation bar,
phrasal search, and PyMEL reference documentation.
This release also includes a new File Referencing tutori-
al, and updates to existing tutorials.
■ What's New In Documentation on page 83
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API

New API classes have been added, and new methods
added to existing classes. For a list of new and updated
API classes, as well as a list of new example plugins,
see the following:
■ What's New in API on page 85
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What's New in General

Updated Interface

Maya’s interface has now been enhanced with a new color scheme and functionality.

These enhancements include:

New File Browser
Maya now has a new File Browser window, which
provides you with option box options in line with the
file browser itself.
Other options include a streamlined display of your
file system, more navigation options relative to your
current folder, and a list of recently opened folder.

2
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■ File Browser in the Basics guide

New Shelf Editor
Maya now has a new Shelf Editor window. This win-
dow features a more streamlined layout that allows
you to modify shelves and shelf items without navig-
ating between tabs. The editor now supports double-
click commands, and editable icon label colors and
backgrounds.
■ Shelf Editor in the Basics guide

Tabbed browsing for Attribute Editor and Channel
Box
You can now open the Channel Box/Layer Editor and
Attribute Editor simultaneously as tabs which reside
on the side of the panel.

Drag and Drop interactivity
You can dock and undock menus and UI elements
around different parts of the UI by dragging and
dropping their dotted edges.
You can also manually resize UI elements by dragging
them along their dotted edges.
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New Color Chooser
Maya now has a new Color Chooser window. This
window features enhanced color history tracking,
multiple color selection methods, the ability to sample
colors directly from images, and customizable 256
color palettes that can be saved and loaded. The Attrib-
ute Editor also features a condensed version of the
Color Chooser window to make color selection
quicker and easier than before.
■ Color Chooser in the Basics guide

For more information, see Interface overview.

Namespace Editor

You can now create and edit namespaces from the
Namespace Editor (Window > General Editors >
Namespace Editor).
■ Namespace Editor in the Basics guide
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Export Maya to Mudbox

You can now export directly from Maya to Autodesk
Mudbox with a single click. This makes cross-applica-
tion interaction faster and easier.
■ Export objects directly to Mudbox in the Basics guide

■ File > Export Selected to Mudbox in the Basics guide

Relative namespaces

You can now refer to namespaces relative to a specific namespace. This allows you to
streamline the Outliner and simplify MEL commands.

■ Set relative namespace mode in the File Referencing guide

Asset and Container nomenclature

For Maya 2011, the term container has been simplified to assets for any and all instances.

■ Asset overview in the Basics guide

Assets with Transforms

You can now create two types of assets in Maya. Assets with Transforms are asset nodes with
associated transforms, meaning you can transform them in the scene and manipulate them
in the DAG hierarchy like you would a group node. Advanced Assets do not have an
associated group transforms and so you must publish nodes manually for them to interact
with the DAG hierarchy.

■ Types of Assets in the Basics guide
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Publish, unpublish, bind, and unbind published nodes from the Attribute Editor

You can now publish, unpublish, bind, and unbind published nodes directly from the
Attribute Editor by clicking the appropriate icon for each published node in the Published
Nodes section.

■ Publish or unpublish nodes in the Basics guide

■ Bind/unbind an attribute or node in the Basics guide

Publish nodes

You can now publish nodes to a container that are not a Root Node, Parent Anchor, or
Child Anchor.

■ Publish or unpublish nodes in the Basics guide

Remove Reference Edits on a Loaded Reference

You can now use the Reference Editor to remove reference edits without having to unload
the reference first.

■ List, copy, or remove reference edits in the File Referencing guide

Export to and Assign Offline Files

You can now import and export reference edits from a scene in Maya to and from an offline
file. This allows you to store edits of a source file in their own external files or apply them
to another file. For example, you can edit a basic walk cycle into a strut, export the strut,
and apply that strut to a different character’s walk cycle.

■ Export to an offline file in the File Referencing guide

■ Assign an offline file in the File Referencing guide

Additional formats for custom icons

Maya now has expanded support for file formats when creating custom icons for the shelf,
assets, the hypergraph, etc. The supported formats now include BMP, GIF, JPG, JPEG, PNG,
PBM, PGM, PPM, XBM, SVG, or XPM. Additionally, images that are not the correct size are
scaled now rather than cropped.

■ Use a custom name or icon for a shelf item in the Basics guide
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Maya 64-bit now supported on Mac OS X

Mac OS X users can access considerably more memory to handle larger and more complex
scenes with the 64-bit version of Maya.

Maya uses IPv6 on Windows Vista

Maya now uses IPv6 on Windows Vista by default. To revert back to IPv4, set the environment
variable MAYA_IP_TYPE = ipv4.

Script Editor auto-completion

The script editor now auto-completes recognized commands and object path names when
you enable the Command Completion and Object Path Completion options.

■ Get help on a MEL command in the MEL and Expressions guide

New user interface commands

There are a number of new UI related commands available. These include:

■ dockControl

■ toolBar

■ treeLister

■ loadUI

In addition, there are also a number of new flags for existing commands including:

■ -icon for confirmDialog

■ -style for promptDialog

■ -visChangeCommand for all scripts

■ -saveMainWindowState and -restoreMainWindowState for windowPref

■ -itemAt and -visualRectAt for iconTextScrollList

■ -droprectCallback for iconTextScrollList

■ -numWidgets and -dumpWidgets for IsUI

A number of compatiblity changes have also been made, including:

■ -parent flag is editable now
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■ hotkey command can accept modifiers in the -key flag argument

■ -backgroundColor flag is respected on all platforms for the control command

■ -minimizeCommand and -restoreCommand are respected on all platforms for the window
command

■ tabLayout control has scroll buttons with right-click menus on all platforms if there is
not enough space to display tabs.

■ Get help on a MEL command
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What's New in
Performance

The following sections describe some performance improvements in Autodesk Maya 2011.

Artisan

■ Faster skin weights painting in backface culling mode.

■ Faster 3D painting on large NURBS surfaces.

Display and User Interface Components

■ Faster texture load for heavy scenes with a lot of textures. Formats optimized are .bmp,
.jpg, .png, .tga.

Rendering

■ Significant performance improvement for scenes using global illumination with the
mia_material_x_passes shader.

Constraints

■ Faster constraint evaluation for the point, parent, and orient constraints based on optimized
weight-checking.

Deformers

■ Non-linear deformers are now multi-threaded.

Solvers

■ Faster nParticle meshing.

3
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Modeling

■ Faster sculpting with Artisan for high polygon models.

General

■ Improvements to file input/output performance.

■ New environment variable MAYA_NO_PARALLEL_MEMCPY that allows you to disable
parallel memory copy. This may improve speed for some systems.
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What's New in Modeling

Bezier curves

You can now create Bezier curves in Maya using the
Bezier tool. Bezier curves are a subset of NURBS curves
that allow you to modify the curvature using a series
of tangents attached to each anchor point on the
curve.
■ Bezier curves in the NURBS Modeling guide

■ Create a Bezier curve in the NURBS Modeling guide

Connect arbitrary components

You can now connect vertices and edges in one oper-
ation with the Connect Components option. This al-
lows you to quickly create edge paths from vertices to
edge mid-points.
■ Connect arbitrary components in the Polygonal Modeling

guide

Spin Edge tool

You can now use the Spin Edge tool to spin an edge
or series of edges around their respective centers,
which changes the vertices they are connected to. Edge
spinning allows you to quickly change the topology
of your mesh.
■ Spin polygonal edges in the Polygonal Modeling guide

4
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Pinch Brush

You can now use the Pinch Brush in the Sculpt Geo-
metry Tool to pull vertices toward each other. This is
useful for making creases more sharply defined.
■ Pinching in the Polygonal Modeling guide

Object level Soft Selection

You can now set the Falloff Mode in the Soft Selection
settings to Object. This allows you to select multiple
objects in a scene and transform them with falloff,
without warping the objects themselves. This is useful
for densely packed objects that you want to space out,
such as trees in a forest.
■ Influence multiple meshes in the Basics guide

Assign Invisible Faces

You can now assign invisible faces to a polygon mesh.
Faces assigned as invisible do not appear in the scene,
yet still exist and can be manipulated. This is particu-
larly useful when you need a face for smoothing or
other polygon operations, but would otherwise like
for it to appear empty in the scene view or render.
■ Make a face invisible in the Polygonal Modeling guide

UV space tiles

UV Tiles allow you to divide the UV texture space into
a series of 1x1 texture spaces, each divided by a bold
border. This is useful to extend your texture space
without losing sight of your border limitations.
■ View > Grid in the Basics guide
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Arbitrary Scale

The Scale Settings in the Scale Tool now allow you to scale along arbitrary axes (such as
Object, Local, World, Normal, etc) similar to the Move Tool.

■ Scale Tool in the Basics guide

Transfer Attributes by topology

You can now transfer attribute values from one mesh to another by matching the mesh’s
topology. This allows you to transfer attribute data even when the arrangement of component
IDs of two identical looking meshes are not the same.

■ Mesh > Transfer Attributes in the Basics guide

UV Edge Loop selection

You can now convert a selection from a Vertex, UV, or Edge selection to a UV Edge Loop
selection. A UV edge loop is similar to an edge loop, but treats UV boundaries as the end of
the loop selection.

■ Select UVs in the Mapping UVs guide

■ Select > Convert Selection > To UV Edge Loop in the Basics guide
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What's New in Animation

Camera Sequencer

The new Camera Sequencer gives you tools to layout
and manage camera shots, then produce movie footage
of the animation in your scene. Even for large scenes,
you can produce movies in the Camera Sequencer to
achieve real-time playback.
With the Camera Sequencer, you can start to layout
shots in Maya, or start by importing your own editor-
ial files containing audio and video clip information
in AAF or FCP format.
Refer to the following topics in the Animation guide
for more information:
■ Camera Sequencer overview

■ Create camera shots

Multiple audio track support

You can now import, display, and playback multiple
audio tracks in a scene.
See the following topics in the Animation guide for
updated information:
■ Example audio workflow

■ Add sound to your animation

■ Audio variables

■ Display audio on the Time Slider

In addition, Maya now includes a test application for
tweaking and testing your sound configuration on
Linux.
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See the following topic for more information:
■ Set up audio on Linux

Scene timecode

A new heads-up display item and scene timecode op-
tions in the Animate menu let you set and display a
timecode in your scene. See Set and display timecode
for the scene in the Animation guide.

Improved global timewarping effects

A new set of options in the Animate menu and in the
Graph Editor let you set up global time warping effects
in Maya. Time warping is also sometimes referred to
as speed ramping, an effect where motion appears to
speed up or slow down within a camera shot.
Using these options, you can create a timewarp curve
– an animation curve that lets you warp the global
time in your scene. Changing the shape of this curve
lets you manipulate the global timing of other anima-
tion curves in your scene.
Refer to the following topics in the Animation guide
for more information:
■ Scene timewarp effects

■ Create timewarping effects

■ Animate > Scene Time Warp menu

Graph Editor improvements
The following improvements have been made to the Graph Editor.

Stacked curve display
A new display mode lets you view a stack of individual
curves in the graph view, rather than viewing all
curves overlapping.

Pre-selection highlight
You can now turn on pre-selection highlighting for
curves, segments, tangents, and keys in the graph view.
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Pin curves in the graph view
You can now pin and unpin channels in the Graph
Editor. When you pin a channel, its curve displays in
the graph area regardless of what is selected.

Improved normalized curve display
The curve normalization options are now located in
the View menu instead of the Curves menu. These
options have been improved so that no extra nodes
are added to the scene when you display normalized
curves. The Normalize icons in the Graph Editor
toolbar have also been updated.
A new Renormalize option lets you manually refresh
the display of normalized curves. (Curves are automat-
ically renormalized when you turn on Display Normal-
ized or the active curve list changes.)

Single-click editing
The Move Nearest Picked Key Tool lets you single click
and drag to adjust tangent handles and keys on a se-
lected curve. A new Selected only option in the Move
Nearest Picked Key Tool options window lets you turn
on single-click editing for all curves.

Display directly connected curves only
A new option in the List menu lets you limit which
curves display in the graph view for a selected channel.

Improved curve color options
A new option in the Edit menu of the Graph Editor
lets you set up a custom color scheme for curves. Select
Edit > Set Curve Colors to open the Curve Colors
window.
This new window lets you associate a curve color with
the name of the attribute. For example, you can set a
Translate X attribute to purple so that Translate X
curves for all objects display in purple.
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Improved filtering options
New filtering options have been added to the Show
menu in the Graph Editor to give you added control
over which attributes display in the graph area.
The new Select Attributes window lets you control
which attributes display using a series of check boxes.
To open this window, select Show > Select Attributes
in the Graph Editor menu bar.
You can also filter the Graph Editor to display only
attributes that are driven by a Driven Key. To see only
attributes with Driven Keys, select an object animated
with Driven Keys, then select Show > Attributes >
Driven By Driven Key.

Pickwalk and view navigation hotkeys
You can now use the pickwalk hotkeys (Right and Left
Arrow keys) to modify selected keys in the Graph Ed-
itor.
In addition, you can move to the previous or next
view in the Graph Editor using the right and left
square bracket keys [ and ]. These are the same hotkeys
that let you move between camera views in the view-
port.
To navigate through views using these hotkeys, click
in the Graph Editor then press [ to move to the previ-
ous view, or ] to move to the next view.

For more information
Refer to the following topics in the Animation guide
for new and updated information:
■ Turn on Pre-selection highlighting in the Graph Editor

■ Pre-Select Highlight

■ Pinning channels

■ Display stacked curves

■ Stacked Curves

■ Display normalized curves

■ Display Normalized

■ Renormalize

■ Use single-click curve editing
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■ Move Nearest Picked Key Tool options window

■ Display directly connected curves only

■ Show Upstream Curves

■ Associate curve colors with attribute names

■ Filter curve display in the Graph Editor

■ Navigate the Graph Editor graph view or Dope Sheet view
area

Animation layer updates

Animation layers help to support the new HIK retargeting workflow. Refer to What's New
in Rigging on page 27 and the following topics in the Character Setup guide for more
information:

■ Retargeting animation

■ Example workflow: Non-destructive retargeting

Improved rotation interpolation options

The Curves > Change Rotation Interp menu in the Graph Editor and Dope Sheet windows
now includes additional quaternion rotation interpolation options.

See the following topics in the Animation guide for updated information.

■ Change Rotation Interp
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What's New in Rigging

Smooth skinning workflow improvements

Several new tools and options in the Paint Skin Weights Tool enhance the smooth skin
weighting workflow.
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See Paint Skin Weights Tool in the Character Setup guide for updated information including
the following improvements.

Tools to copy, paste, move, and fix weights
New buttons let you do the following tasks with one
click:
■ Copy and paste: Copy a weight value from one vertex,

paste it to other vertices.

■ Weight hammer: Re-assign selected vertices with weight
values from neighboring vertices, fixing weights that cause
spiky or otherwise undesirable deformation.

■ Move weights: Re-assign the joint(s) that you want to influ-
ence selected vertices.

■ Show influences: Easily identify which influences affect se-
lected vertices.

Influences list improvements

■ Updated Sort options let you display influences in a tree-
view hierarchy that you can expand and collapse.

■ Quickly edit the influence color by clicking new Influence
color buttons.

■ Reduce the number of influences displaying in the list using
the new filter. This makes it easier to locate and select influ-
ences when working with a complex rig.

Selection options

■ An Invert Selection button lets you quickly invert your selec-
tion in the Influences list.

■ New selection modes let you quickly switch between paint-
ing skin weights and painting to select skin points. Toggle
between Paint, Select, and Paint Select to accomplish tasks
like Fix smooth weights, or Move weights to other influences.

Ramp color feedback
Use a color ramp to assign color values for weights,
making it easier to see small values when painting,
and to determine if a joint is influencing unwanted
vertices. Color swatches next to the color ramp let you
quickly set colors to represent values of 0 and 1.
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Refer to the following topics in the Character Setup
guide for more information:
■ Copy smooth skin weights

■ Fix smooth weights

■ Move weights to other influences

■ Skin > Edit Smooth Skin > Move Weights to Influences

Interactive skin binding

This smooth binding method lets you quickly set ini-
tial skin weights using interactive volume manipulat-
ors. By adjusting the shape, length, and position of
the manipulators in the viewport, you define the area
of the mesh affected by each influence.
Interactive skin binding can help you achieve a
quicker initial bind and better smooth skin deforma-
tion. Once you establish the rough weighting with
the manipulators, you can refine weights using the
weight painting tools.
See the following topics in the Character Setup guide:
■ Interactive bind for smooth skinning

■ Use interactive bind for smooth skinning

Dual quaternion skinning

Traditional smooth skinning in Maya uses linear
skinning to make a mesh follow a character’s joints.
In areas such as a wrist or elbow, this method can
result in a ‘bow tie’ or ‘candy wrapper’ effect where
the mesh loses volume as a bone twists on its axis.
Dual quaternion is a new method of smooth skinning
designed to eliminate these undesirable deformation
effects.
A new menu in the Smooth Bind Options window
(and in the skinCluster) lets you select whether to use
classic smooth skinning, dual quaternion skinning,
or blend between both methods at a vertex level on
the same character.
See the following topics for more information:
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■ Smooth skinning methods

■ Blend smooth skinning methods

■ Bind smooth skin

■ Skinning Method

Non-destructive animation retargeting

The Autodesk® HumanIK® character solver is now in-
tegrated in Maya to provide an improved character
animation retargeting solution.
Using the HumanIK plug-in with animation layers lets
you retarget character animation and modify it non-
destructively. The new retargeting workflow is a live
process, letting you adjust various parameters and see
the results immediately.
Refer to the following topics in the Character Setup
guide for more information:
■ HumanIK in Maya

■ Retargeting animation

■ Example workflow: Non-destructive retargeting

Joint drawing styles

New options in the joint node give you alternate ways
of representing and visualizing a character’s skeleton.
You can change how joints are drawn using the Draw
Style drop-down list. This list now includes options
to draw joints as circles, squares, or sticks. See Draw
Style and Change joint display options in the Character
Setup guide.
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Improved smooth skin weight normalization

A new Normalize Weights drop-down menu in the Paint Skin Weights Tool and in the
skinCluster node has been added to improve the smooth skin weight normalization process.
This menu lets you set how you want weights normalized, which can reduce the incidence
of small weights unintentionally distributed across the mesh as you paint and smooth.

The Interactive normalization mode replicates the weight normalization from previous
versions of Maya, while the new Post normalization mode gives you the improved
normalization behavior.

See Smooth skin weight normalization and Set normalization mode and normalize weights
for updated information.

New constraints

Point on Poly constraint

A new Point on Poly constraint lets you constrain an object to a mesh so that the constrained
object sticks to the mesh as the mesh deforms. Using this constraint you can create effects
such as a button on a jacket, where the button sticks in place as the jacket deforms.

See Point on Poly constraints in the Constraints chapter of the Character Setup guide.

Closest Point constraint

A new Closest Point constraint provides a quick way to calculate the closest point on a
mesh, NURBS surface, or curve, relative to an input position. You can use the constraint for
calculation purposes only, or create locators to mark the closest point.

See Closest Point constraint in the Constraints chapter of the Character Setup guide.

Deformer enhancements

Mirror deformer weights

A new item in the Edit Deformers menu lets you mirror weights for the blend shape, cluster,
jiggle, and wire deformers.

See Mirror deformer weights and Edit Deformers > Mirror Deformer Weights in the Deformers
guide.

Lattice deformer hotkeys

You can now use the pickwalk hotkeys to navigate along lattice deformer points. See Edit
lattice deformers in the Deformers guide for updated information.
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Wrap deformer enhancements

A new Falloff Mode for the wrap deformer lets you select from Volume and Surface options.
The default Volume mode sets the wrap deformer to use direct distances to calculate weights
for wrap influence objects, and the new Surface mode sets the deformer to use surface-based
distances to calculate the weights.

See Falloff Mode in the Deformers guide.

Support for negative weights in the Blend Shape deformer

A new Support Negative Weights attribute in the blendShape node lets you set whether you
want to allow negative weight values. See Support Negative Weights in the Deformers guide.
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What's New in Paint Effects

New Leaf and Flower attributes

Paint Effects now includes Leaf Face Sun
and Flower Face Sun attributes that let you
change the position of leaves and flowers
so that they face toward or away from the
sun. A Sun Direction attribute sets the sun's
location in the scene.
Leaf Face Sun and Flower Face Sun are
based on phototropism, which is the
movement or growth of a plant in response
to the direction of a light source. Leaf Face
Sun and Flower Face Sun apply to the fol-
lowing 3D Paint Effects strokes:
■ Flower and flower meshes

■ Plants and plant meshes

■ Trees and tree meshes

■ Underwater (that have flowers or leaves)

Leaf Face Sun and Flower Face Sun have
been added to the Leaf Curl and Petal Curl
sections of the stroke's Growth attributes.
■ Leaf Face Sun

■ Flower Face Sun

■ Sun Direction
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Transfer All Strokes to New Object

A new Transfer All Strokes to New Object feature lets you transfers strokes from a painted
object to another object. For example, you can use this feature to transfer painted eyebrows
from a low resolution mesh character mesh to a high resolution mesh character.

Transfer All Strokes to New Object transfers all the paint effects strokes that are present on
the object. If both objects have paint effects strokes, then selection order is used to determine
the source and target objects. Otherwise, the object without paint effects strokes gets the
transferred strokes.

■ Paint Effects > Curve Utilities >Transfer All Strokes To New Object
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What's New in Dynamics

Dynamic Relationships Editor improvements

Maya has an improved Dynamic Relation-
ships Editor that lets you select, view, and
edit connections for multiple objects. You
can then edit the dynamic relationships for
each object individually.
■ Dynamic Relationships Editor

■ Connect and disconnect fields, emitters, and
collision objects

Convert displacement to polygons with history

You can now convert a displacement to a polygon object that has construction history. When
you use Convert > Displacement to Polygons with History, the new mesh retains the history
of the displacement.

Displacement to Polygons with History is useful in Dynamics and nDynamics effects such as
colliding nParticles with a Maya ocean.

■ Modify > Convert > Displacement to Polygons with History

8
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What's New in Fluid Effects

Auto Resize

Maya Fluid Effects now includes an Auto Resize feature.
Auto Resize dynamically resizes 2D and 3D fluid con-
tainers when the density near the edges of the fluid
reaches the set Auto Resize Threshold value. With Auto
Resize on, Maya allows the container to only extend
to regions with density, rather than keeping the fixed
resolution and offset that the grid started out with.
The smaller simulation region increases simulation
speed, reduces rendered times, uses less memory, and
results in smaller fluid cache files.
Auto Resize works well with fluid effects that move,
such as a missile vapor trail or the rolling smoke of an
explosion, as it keeps the fluid container relatively
small.
■ Dynamically resize a fluid container

■ Set a fluid container to dynamically resize

■ Auto Resize

9
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Self Attraction and Repulsion

Fluid Effects now includes Self Attraction and Repul-
sion attributes that generate attractive and repulsive
forces between the voxels in 2D and 3D fluid contain-
ers. Using Self Attraction and Repulsion attributes, you
can specify whether the forces use density or temper-
ature grid values as well as control the strength of the
attraction and repulsion force.
You can use Self Attraction and Repulsion to create
effects such as swirling gas clouds and galaxies that
contract and expand. Using a strong self repulsion
force, you can simulate rapidly expanding gases to
create the look of realistic explosion flashes.
■ Using self attraction and repulsion forces

■ Self Attraction and Repulsion

New Dynamic Simulation attributes

New Dynamic Simulation attributes improve the quality of fluid simulations.

The new attributes include the following:

Forward Advection
Forward Advection is a new method that you can use
for calculating Density, Temperature, and Fuel grids.
When on, these grids are solved using a mass con-
serving forward propagation technique that pushes
density forward through the grid. Fluid effects solved
using Forward Advection can produce fewer artifacts
when the High Detail Solve option is used, and results
in less diffusion than the default solve method. For-
ward Advection can also resolve instances where
density remains static in voxels.
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■ Forward Advection

Substeps
Use Substeps to specify the number of times the solver
performs calculations per frame. Substeps are useful
for improving the stability and simulation results of
fast-moving fluids, fluids with high density grids, and
when the High Detail Solve option is used.
■ Substeps

Output mesh per-vertex shading attributes

You can now generate per-vertex color, opacity, and
incandescence data when you convert your fluid object
to a polygon mesh. When on, Color Per Vertex, Opa-
city Per Vertex, and Incandescence Per Vertex generate
per-vertex data which is derived from the fluid object's
color, opacity, and incandescence values. The output
mesh per-vertex data is color set data that can be ap-
plied to the polygon object like other color set data.
■ Converting fluids to polygons

■ Color Per Vertex

■ Opacity Per Vertex

■ Incandescence Per Vertex

Velocity Per Vertex for motion blur

You can now create motion blur when you render
fluid output meshes. A new Velocity Per Vertex attrib-
ute generates velocity per vertex data when a fluid
object is converted to an output mesh. When you
render your fluid output mesh using mental ray for
Maya, velocity per-vertex data generates motion blur
in the rendered output.
■ Create motion blur

■ Velocity Per Vertex
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Uvw Per Vertex

You can now generate a UVW coordinate system for
your fluid output meshes. A new Uvw Per Vertex at-
tribute outputs UVW coordinates when a fluid object
is converted to an output mesh. You can use the Uvw
per-vertex data to assign textures to fluid output
meshes.
You can use the UV Texture Editor to modify the
output mesh UVs like any other polygon surface.
■ Uvw Per Vertex

Fluids Lighting

A number of new Lighting attributes have been added to Fluid Effects that let you preview
the lighting and shadowing of your fluid in the workspace before rendering. There are now
more internal lights, including point, directional, and ambient lights, that you can use to
light your fluid effect. Using internal lighting decreases fluid render times. See Lighting
fluids with internal lights.

New fluid lighting features include the following attributes:

Shadow Diffusion
Controls the softness of the fluid's internal shadow,
simulating local light scattering. Shadow Diffusion
can only be seen in the workspace not in a rendered
fluid. To use Shadow Diffusion effects in your finalized
fluid, you can use Playblast to output simulated
frames.
■ Shadow Diffusion

Light Type
Use Light Type to select the type of internal light you
want to use with the fluid when displaying it in the
workspace. You can now select an internal diagonal,
directional, or point light. If Real Lights is off, the se-
lected internal light is used to light the fluid for ren-
dering.
The internal point light also includes a Point Light
Decay attributes that let you control how quickly the
light's intensity decreases with distance.
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■ Light Type

■ Point Light Decay

Light Brightness and Light Color
You can use Light Brightness and Light Color to set
the intensity and color of the selected internal light.
Light Brightness and Light Color are similar to the
intensity and color attributes that are used with scene
lights.
■ Light Brightness

■ Light Color

Ambient lighting
Fluid Effects now includes ambient lighting which
you can preview in the workspace before rendering.
Using ambient light attributes, you can control the
intensity, color, and diffusion of the ambient light.
■ Ambient Brightness

■ Ambient Diffusion

■ Ambient Color

New Dynamic Simulation attributes

New Contents Details attributes let you add more detail and turbulence to your fluid effects.

These new attributes include the following:

Noise
Density, Temperature, and Velocity now include a
Noise attribute that randomizes density, temperature,
and velocity grid values. You can use Noise to create
turbulence as well as to add detail to a fluid effect.
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■ Noise

Tension
Density and Temperature now include a Tension at-
tribute that lets you smooth ranges of density and
temperature into round shapes, making the density
and temperature boundaries more defined in the fluid.
You can use Tension to create effects that are similar
to the effect of surface tension in liquids.
■ Tension

Gradient Force
Density now includes a Gradient Force attribute that
applies attractive and repulsive forces along the direc-
tion of the density gradient. Positive Gradient Force
values push in the direction of increasing density,
producing an attractive force. Negative values push
density away from itself, producing a repelling force.
Gradient Force is similar to Self Attraction and Repul-
sion, but the effect of Gradient Force is localized to
the adjacent voxels and takes less time to calculate
than Self Attraction and Repulsion.
■ Gradient Force
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Boundary Draw improvements

The Outline option for the Boundary Draw attribute
has been improved on 2D fluid containers. A dotted
line displayed around the container indicates the po-
tential volume of the 2D fluid.
■ Boundary Draw

Emit fluids from nParticles

You can now emit fluid from nParticle objects using
Emit from Object. To control the fluid emission rate,
you can either use fluid emitter attributes, or you can
use nParticle per-particle rate and per-particle radius
attributes.
For example, you can use a per-particle ramp or an
expression to control the radius of fluid emission based
on the per-particle radius of nParticles. You can also
emit fluid from Maya classic particles.
Emitting fluid from nParticles lets you combine fluid
and nParticle effects in the same simulation. This
provides better control over smoke, fire, dust, or debris
clouds that result from nParticle collisions and explo-
sions.
■ Emit fluid properties with nParticles

■ Use Per-Point Rate

■ Use Per-Point Radius
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New fluid emitter attributes

Maya 2011 includes the following new fluid emitter attributes:

Rate (Percent)
A new Rate (Percent) attributes lets you scale the indi-
vidual emission rates of all fluid grids, including
Density, Heat, and Fuel with one attribute. Rate (Per-
cent) sets fluid emission rate as a percent.
■ Rate (Percent)

■ Emission rate and method

Emission method
New emission methods for Density, Heat, and Fuel let
you specify how contents are emitted into fluids. The
default Add method adds contents using a continuous
emission rate. This is the same emission method used
by fluids in previous versions of Maya.
A new Replace emission method lets you specify the
total amount of contents emitted in the fluid. It can
be used to obtain specific amounts of density, heat,
and fuel without needing to reset the fluid’s initial
state from an advanced frame. This is useful for quickly
simulating effects such as rising heat and wind tunnels.
■ Fluid Attributes

■ Emission rate and method

Emission maps
There are now emission maps for Density, Heat, and
Fuel. Using the emission map attributes, you can map
a 2D texture to control emitted density, temperature,
and fuel. Texturing the emission is now supported.
■ Emit fluids using emission maps
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■ Fluid Attributes

Motion Streak
When on, Motion Streak smooths emission stamps
into a continuous fluid streak. Motion Streak is most
useful for effects with fast moving emitters, which can
cause emission stamping.
■ Motion Streak

Keep Voxels Square

Use Keep Voxels Square to set a fluid container's resolution based on the fluid Resolution
and Size values while maintaining square voxels in the local space of the fluid. Square voxels
can provide better fluid simulation and rendering results.

When Auto Resize is on, voxels are kept square by default.

■ Change fluid resolution

■ Keep Voxels Square

Base Resolution

When Keep Voxels Square is on, you can use Base Resolution to simultaneously set the X,
Y, and Z Resolution values of your fluid container.

■ Change fluid resolution

■ Base Resolution

Texture Rotate

A new Texture Rotate attribute lets you rotate the fluid's built-in texture.

■ Texture Rotate

Normalized Dropoff

A new Normalized Dropoff attribute for volume emitters is now fixed relative to the emitter’s
scale, rather than to Worldspace. This ensures that fluid simulations remain consistent if
the fluid container and emitter are scaled together. It also improves Fluid Dropoff for Cube
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volume emitters by using a smooth dropoff towards the volume boundaries. In previous
versions of Maya, a cylindrical shaped dropoff is used with Cube volume emitters.

■ Normalized Dropoff

Use Distance

A new Use Distance attribute lets you use Min Distance and Max Distance with Surface and
Curve emitters. In previous versions of Maya, to use Min Distance and Max Distance with
Surface and Curve emitters, Min Distance has to be set to a value other than 0. You can now
set Min Distance to 0 for Surface and Curve emitters.

■ Use Distance

Emission Speed Attributes

A number of new Emission Speed Attributes let you control speed and velocity emission for
all emitter types. For example, you can adjust emitted speed along the tangent of a Curve
emitter or along the axis of a Volume emitter.

■ Emission Speed Attributes

High Quality Solve improvements

Fluid simulations solved with the High Quality Solve option are now more stable and have
fewer artifacts when Forward Advection and Substeps are used.

■ High Detail Solve

■ Forward Advection

■ Substeps
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What's New in nCloth

Collide Strength

A new Collide Strength attribute lets you
specify the strength of collisions between
nCloth and other Nucleus objects.
You can use the Paint nCloth Attributes
Tool to create a Collide Strength vertex map
or texture map to dampen or disable colli-
sions on selected nCloth and passive colli-
sion object components. In previous ver-
sions of Maya, the easiest way to exclude
selected vertices from collision is to create
Exclude Collide Pairs constraints. Collide
Strength Maps have also been added to
nCloth objects.
Passive collision objects also have new
Collide Strength and Collide Strength Map
attributes.

■ Collide Strength

■ Collisions

Paintable Rest Length Scale

You can now can use the Paint nCloth At-
tributes Tool to create a Rest Length Scale
vertex map or texture map to set Rest
Length Scale on selected nCloth object
components. Painting Rest Length Scale
values per-vertex is useful for creating
ruffles and flares in nCloth, and for simu-
lating textured fabrics, such as seersucker.
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■ Rest Length Scale Map Type / Rest Length Scale
Map

■ nMesh > Paint Vertex Properties

■ nMesh > Paint Texture Properties

New Cacheable Attributes option

A new Dynamic State option for Cacheable Attributes provides improved results for resuming
nCloth simulations off the end of an nCache. Dynamic State caches the X,Y, and Z positions
of an nCloth object's vertices, the object's velocity, as well as internal state information.

■ Dynamic State

Bend Solver

A new Bend Solver attribute lets you set the method used to solve Bend Resistance. Bend
Solver methods can now better resolve instances of vertex cross-over and flipped geometry
than the method used in previous versions of Maya.

■ Bend Solver
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What's New in nParticles

Per-particle rotations

New Rotation attributes let you control how Nucleus
drives nParticle rotations on a per-particle basis. Rota-
tion attributes can also be used to rotate instanced
geometry. Rotation Friction and Rotation Damp attrib-
utes let you control the rate of particle rotations.
Per-particle rotations are useful for creating realistic,
randomly moving objects such as flying debris in an
explosion effect.
■ nParticle Rotation

■ Rotation

■ Rotate instanced geometry
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Collision Ramps

nParticles now includes internal per-particle ramps
for collision attributes. You can use Collision Ramps
to set per-particle Collide Strength, Bounce, Friction,
and Stickiness on nParticle objects, and scale attribute
values based on nParticle properties such as age, radius,
or speed.
■ Collision Ramps

■ nParticle internal ramps and per-particle attributes

Surface Tension

A new Surface Tension attribute lets you add realistic
surface tension to your nParticle liquid simulations.
In nature, surface tension is the attractive force
between the molecules of liquids, and is most notice-
able in phenomena such as the formation of water
beads or liquid droplets on surfaces. Surface Tension
mimics this characteristic by creating contracting and
expanding behavior on the surface of a liquid nParticle
object as it moves.
A Surface Tension Scale internal ramp lets you set
Surface Tension on a per-particle basis.
■ Surface Tension

■ Surface Tension Scale

■ Liquid Simulations
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Viscosity Scale ramp

Maya 2011 includes a Viscosity Scale ramp that lets
you set per-particle Viscosity values of your liquid
simulation nParticles. Using the Viscosity Scale ramp,
you can scale Viscosity values based on nParticle
properties such as age, radius, or speed.
■ Viscosity Scale

■ Liquid Simulations

nParticles constraint improvements

You can now add nConstraints to nParticles that are
emitted into your scene after initial state. For example,
you can add a Component to Component constraint
to emitted nParticles to create a continuous chain of
connected particles.
In previous versions of Maya, only initial state
nParticles can have constraints.
■ Constraining Nucleus objects

■ Create and Edit nParticle Constraints

nParticles output mesh improvements

Maya 2011 includes performance improvements when
converting an nParticle object to a polygon object.
These improvements are most noticeable when using
Triangle Mesh or Quad Mesh as the Mesh Method.
In Maya 2010, meshes output as quads (Mesh Method
set to Quads) may have issues with non-manifold
geometry or spikes in the areas joining the separate
lobes of the isosurface. Many of these problems have
been fixed in Maya 2011. Also, the initial quad surface
generated by the mesh conversion is now smoother,
even when Mesh Smoothing Iterations are set to 0.
■ nParticle output meshes

■ Convert nParticles to polygons
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Output mesh per-vertex shading attributes

You can now generate per-vertex color, opacity, and
incandescence data when you convert an nParticle
object to a polygon mesh. When on, Color Per Vertex,
Opacity Per Vertex, and Incandescence Per Vertex
generate per-vertex data which is derived from the
nParticle object's per-particle color, opacity, and incan-
descence values. The output mesh per-vertex data can
be used as color set data and applied to the polygon
object like other color set data.
■ Output mesh per-vertex shading

■ Set nParticle output mesh properties

■ Output Mesh

Velocity Per Vertex for motion blur

You can now create motion blur when you render
nParticle output meshes. A new Velocity Per Vertex
attribute generates velocity per vertex data when an
nParticle object is converted to an output mesh. When
you render your nParticle output mesh using mental
ray for Maya, velocity per-vertex data is used for ren-
dering with motion blur.
■ Create motion blur

■ Velocity Per Vertex
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Uvw Per Vertex

You can now generate a UVW coordinate system for
your nParticle output meshes. A new Uvw Per Vertex
attribute outputs UVW coordinates when an nParticle
object is converted to an output mesh. You can use
the coordinates to assign textures to nParticle output
meshes.
You can use the UV Texture Editor to modify the
output meshes' UV topology like any other polygon
surface.
■ Uvw Per Vertex

Collide Strength

A new Collide Strength attribute lets you specify the strength of nParticle collisions, including
self-collisions and collisions with other Nucleus objects. Using Collide Strength, you can
specify if an nParticle object fully collides, partially collides, or does not collide with other
objects.

A new Collide Strength Scale ramp lets you set Collide Strength on a per-particle basis. Using
a Collide Strength Scale ramp, you can dampen or disable collisions on individual nParticles
based on properties such as age, speed, or radius.

■ Collide Strength

■ Collide Strength Scale
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What's New in Rendering
and Render Setup

New Viewport 2.0

The new Viewport 2.0 provides large scene perform-
ance optimization and higher quality lighting and
shaders. It allows for higher interactivity: you can
tumble complex scenes with many objects as well as
large objects with heavy geometry.
To switch to Viewport 2.0, select Renderer > Viewport
2.0 from the Panel Menus.
■ Visualize interactively in Viewport 2.0

■ Renderer > Viewport 2.0

■ Limitations of Viewport 2.0

■ Visualize interactively in the scene view
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New Hypershade design

You can now use the new Hypershade design for an
easier and faster way to create render nodes. The new
design provides a search feature and allows for easy
navigation.
You can also create a favorites list in order to easily
access your most commonly used shaders.
The Create Render Node window and the Assign New
Material window also feature this new design.
Furthermore, the Assign New Material window has
additional features that simplify your workflow when
you assign a shader to surfaces.
Additional utility nodes, such as Add Matrix, Choice,
and Decompose Matrix, are now also available through
the Hypershade.
■ Create bar

■ Hide, resize or customize the Create bar

■ Create a node

■ Creating and using favorites

■ Create Render Node window

■ Assign New Material window

■ Utilities

New 2D Pan/Zoom feature available

You can now use this feature to pan and zoom in 2D
and view the results in your scene view for detailed
tracking and rotoscoping work. Using this feature, you
can easily toggle in and out of pan/zoom mode.
The pan/zoom mode does not render by default and
therefore you have the option of rendering the full
camera view or the pan/zoom view. In addition, you
can also create 2D Pan/Zoom bookmarks.
You can access this feature by selecting View > Camera
Attribute Editor > Display Options > 2D Pan/Zoom or
by selecting View > Camera Tools > 2D Pan/Zoom
Tool.
■ Panning and zooming in 2D

■ Display Options
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■ Ignore 2D Pan/Zoom

■ View > Camera Tools

■ 2D Pan/Zoom Tool

■ Panel toolbar

■ Maya Hotkeys

New stereoscopic camera features

New Multi-Camera Rig Tool
Use the Multi-Camera Rig Tool to create a multi-cam-
era rig of two or more stereoscopic cameras. You can
customize the default multi-camera rig or define your
own. You can customize the number of layers in your
rig as well as the rig type for every layer. Choose
between the standard stereo camera or any custom rig
that you have registered.
■ Multi-Camera Rig Tool

■ Create a multi-camera rig

■ Stereo > Editors > Custom Multi Rig

Linking a stereo camera with a set of objects
You can link your stereo camera with a group of ob-
jects as a set. This feature is most useful when you
have multiple stereo cameras in your scene and you
want to have different stereo settings for different ob-
jects.
Select Stereo > Make Links to link your camera with a
set of objects.
■ Linking a stereo camera with a set of objects

■ Stereo > Make Links

■ Stereo > Break Links
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Color management support

Color profile support
You can now control the color profile associated with
inputs to and outputs from the rendering process.
Using this feature, you can specify a color space for
input textures and specify to the renderer a color space
for use with shaders and color calculation. You can
associate color profiles with these elements:
■ file textures

■ render passes

■ mentalrayTexture nodes

■ mentalrayOutputPass nodes

To enable color management, use the Render Settings:
Common tab. Then, you can select the color space for
each of your individual nodes via its Attribute Editor.
■ Using color management in your scene

■ Render Settings: Common tab

■ Render pass Attribute Editor

■ File

■ Color Profile

Displaying HDR images in the Render View
You can now display 32-bit floating point HDR images
in the Render View. This way, you can use color
management to control the color profile associated
with the image file and the display output. You can
also apply color grading and preview it in the Render
View window, as well as specify a custom calibration
file.
Furthermore, with this feature, you can adjust the
image contrast and exposure, allowing you to view
details in over-bright and over-dark regions of an HDR
image.
You can access the color management options from
the Render View window by selecting Display > Color
Management.
■ Displaying HDR images in the Render View
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■ Using color management in the Render View: sample
workflow

■ Render View color management node

■ Rendering preferences

New ambient occlusion pass attributes

You can now customize your ambient occlusion pass
by tweaking these attributes: number of ambient oc-
clusion rays, Spread, Output Mode, Maximum Distance
and so forth. You can access all of these attributes
through the ambient occlusion pass Attribute Editor.
■ Ambient Occlusion render pass attributes

New render passes supported by mia_material_x_passes shader

The mia_material_x_passes shader now provides support for additional render passes such
as: Diffuse Without Shadows, Direct Irradiance Without Shadows, Raw Shadow, Shadow,
Specular Without Shadows, Translucence Without Shadows.

For a list of all the passes that are supported by the mia_material_x_passes shader, see:

■ mi_metallic_paint_x_passes, mia_material_x_passes, misss_fast_shader_x_passes,
mi_car_paint_phen_x_passes shaders

New final gather attributes available

A new No FG Caching option has been added to the Render Settings: Indirect Lighting tab
that enables you to disable final gather caching completely and always perform the full and
accurate final gather computation. This option may reduce rendering times, depending on
your scene complexity.

The new Normal Tolerance option allows you to specify the maximum angle up to which
a final gather point normal may deviate from the surface normal for the final gather point
to be considered for interpolation. A higher value reduces rendering time while a lower
value may slow down rendering.

■ Final Gather Quality

■ Final Gather Tracing
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Optimization for single objects now available for ambient occlusion and custom transfer
maps

You can now choose between optimization for multiple objects and for single objects when
creating ambient occlusion and custom transfer maps. Select Lighting/Shading > Transfer
Maps to open the Transfer Maps editor and select between these two options under the
Optimization drop-down box.

■ Lighting/Shading > Transfer Maps

New mental ray shaders added

Two new mental ray shaders are now included: mia_photometric_light and mia_ciesky.

The mia_photometric_light shader balances the photon energy and density with the light
intensity and the mia_ciesky shader can be used for lighting analysis.

■ mia_photometric_light

■ mia_ciesky

Backburner now supported for use with Maya on Mac OS X

You can now use Backburner with Maya on the Mac OS X platform.

■ Network rendering using Maya with Backburner

New shadowmap camera for directional lights

You can now use the new shadow map camera to control the area of focus for directional
lights.

■ Use Shadow Map Camera (directional lights only)
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What's New in MEL and
Python

New startup flag to enable compatibility warnings

A new Maya startup flag, -3, has been added to enable Python 3000 compatibility warnings.

■ Additional Maya startup flags

New advanced techniqes section added

The Python book has a new advanced techniques section that provides guidelines for creating
an editor window using Python.

■ Creating an editor window using Python

PyMEL installed with Maya

PyMEL is now installed with Maya. For more information about PyMEL, see the PyMEL
documentation.

■ Using PyMEL

New commands

The following commands have been added:

■ aaf2fcp

■ adskAsset

■ adskAssetLibrary

■ adskAssetList

■ adskAssetListUI
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■ audioTrack

■ autoSave

■ bezierAnchorPreset

■ bezierAnchorState

■ bezierCurveToNurbs

■ bezierInfo

■ cameraSet

■ componentBox

■ containerBind

■ containerPublish

■ copyDeformerWeights

■ curveBezierCtx

■ curveRGBColor

■ dbcount

■ dbmessage

■ deformerWeights

■ deviceManager

■ dockControl

■ exportEdits

■ fileDialog2

■ flowLayout

■ interactionStyle

■ loadUI

■ movieInfo

■ nodeTreeLister

■ nurbsCurveToBezier

■ ogs
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■ ogsdebug

■ ogsRender

■ panZoom

■ panZoomCtx

■ pointOnPolyConstraint

■ polyConnectComponents

■ polyHole

■ polySpinEdge

■ polyUVRectangle

■ relationship

■ resourceManager

■ sequenceManager

■ shot

■ shotTrack

■ shotRipple

■ skinBindCtx

■ timeCode

■ toolBar

■ treeLister

■ volumeBind

Obsolete commands

The following commands have been removed:

■ characterOutlineEditor

■ dgcount

■ dynRelEdPanel

■ dynRelEditor
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■ finder

■ imageElement

■ lightListEditor

■ lightListPanel

■ listerEditor

■ newPanelItems

■ rangeElement

■ renderLayerButton

■ sceneViewer

■ setEditor

■ shellField

■ textElement

■ xpmPicker

Changes to existing commands

Almost all flags which take MEL scripts now support Python scripts as well.

All commands for creating controls and layouts have added the following flags:

■ -enableBackground/ebg

■ -fullPathName/fpn

■ -visibleChangeCommand/vcc

All constraint commands have added a -layer/l flag.

All artisan paint contexts have added the following flags:

■ -colorRamp/cr

■ -rampMinColor/rmc

■ -rampMaxColor/rxc

■ -useColorRamp/ucr

■ -useMaxMinColor/umc

64 | Chapter 13   What's New in MEL and Python



Controls can now be reparented (-parent flag is editable).

The following flags have been added to the iconTextButton, iconTextCheckBox,
iconTextRadioButton, iconTextStaticLabel, nodeIconButton and shelfButton commands:

■ -overlayLabelBackColor/olb

■ -overlayLabelColor/olc

For the dynPaintEditor, imageWindowEditor, renderWindowEditor and textureWindow
commands, their -scaleBlue/db, -scaleGreen/dg and -scaleRed/sr flags now take float
arguments rather than int.

For the manipMoveContext, manipRotateContext and manipScaleContext commands, their
-activeHandle/ah flag now takes an int rather than float.

In addition, there have been the following changes to individual commands:

about

Flags added:

■ -fontInfo/foi

■ -qtVersion/qt

■ -windowManager/wm

allNodeTypes

Flags added:

■ -includeAbstract/ia

animCurveEditor

Flags added:

■ -displayNormalized/-dn;

■ -preSelectionHighlight/psh;

■ -renormalizeCurves/rnc;

■ -stackedCurves/sc;

■ -stackedCurvesMin/scm;

■ -stackedCurvesMax/scx;
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■ -stackedCurvesSpace/scs;

■ -showUpstreamCurves/suc

animView

Flags added:

■ -nextView/nv

■ -previousView/pv

artAttrSkinPaintCtx

Flags added:

■ -paintSelectionMode/spm

■ -skinPaintMode/spm

button

Flags changed:

■ -align flag is now ignored

■ -actionIsSubstitute flag is now ignored.

checkBox

Flags changed:

■ -align flag is now ignored

control

Flags changed:

■ -backgroundColor flag is respected on all platforms

camera

Flags added:

■ -horizontalPan/hpn

■ -panZoomEnabled/pze
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■ -renderPanZoom/rpz

■ -verticalPan/vpn

■ -zoom/zom

cameraView

Flags added:

■ -bookmarkType/typ

clipEditor

Flags added:

■ -clipStyle/cs

■ -manageSequencer/ms

Flags removed:

■ -characterOutline/co

cmdScrollFieldExecuter

Flags added:

■ -commandCompletion/cco

■ -objectPathCompletion/opc

■ -spacesPerTab/spt

■ -showTooltipHelp/sth

■ -tabsForIndent/tfi

commandLine

Flags added:

■ -holdFocus/hf
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commandPort

Flags added:

■ -sourceType/stp

■ -pickleOutput/po

confirmDialog

Flags added:

■ -icon/icn

container

Flags added:

■ -includeNetworkDetails/ind

■ -isContainer/isc

■ -type/typ

■ -unbindChild/unc

■ -unbindParent/ubp

containerProxy

Flags added:

■ -fromTemplate/ft

■ -type/typ

containerTemplate

Flags added:

■ -addBindingSet/abs

■ -bindingSetList/bsl

■ -childAnchor/can

■ -parentAnchor/pan

■ -publishNodeList/pnl
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■ -removeBindingSet/rbs

■ -rootTransform/rtn

■ -updateBindingSet/ubs

copySkinWeights

Flags added:

■ -noBlendWeight/nbw

■ -normalize/nr

■ -sampleSpace/spa

curveCVCtx and curveEPCtx

Flags added:

■ -bezier/bez

cycleCheck

Flags added:

■ -firstCycleOnly/fco

■ -firstPlugPerNode/fpn

■ -lastPlugPerNode/lpn

■ -listSeparator/ls

directKeyCtx

Flags added:

■ -selectedOnly/so

editorTemplate

Flags added:

■ -addAdskAssetControls/aac
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error

Flags added:

■ -showLineNumber/sl

file

Flags added:

■ -applyTo/at

■ -compress/cmp

■ -exportUnloadedReferences/eur

■ -mapPlaceHolderNamespace/mns

■ -mergeNamespacesOnClash/mnc

■ -preserveName/pn

Flags changed:

■ -command/c now takes a second parameter which is the restore script

findType

Flags added:

■ -deep/d

■ -type/t

Flags removed:

■ -all

frameLayout

Flags changed:

■ -labelAlign and -labelWidth flags are now ignored.
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getPanel

Flags added:

■ -atPosition/ap

group

Flags added:

■ -useAsGroup/uag

hotBox

Flags added:

■ -noClickPosition/ncp

■ -position/pos

hotkey

Flags changed:

■ -key flag can accept modifiers

iconTextButton

Flags changed:

■ -actionIsSubstitute flag is now ignored.

iconTextScrollList

Flags added:

■ -dropRectCallback/drc

■ -itemAt/ia

■ -visualRectAt/vra

ikSystem

Flags changed:

■ -solverTypes/st no longer takes an argument

 | 71

../Commands/getPanel.html
../Commands/group.html
../Commands/hotBox.html
../Commands/hotkey.html
../Commands/iconTextButton.html
../Commands/iconTextScrollList.html
../Commands/ikSystem.html


itemFilterAttr

Flags added:

■ -hasDrivenKey/hdk

ls

Flags added:

■ -containers/con

■ -lockedNodes/ln

■ -persistentNodes/pn

■ -referenceNodes/rn

■ -undeletable/ud

lsThroughFilter

Flags added:

■ -item/it

lsUI

Flags added:

■ -dumpWidgets/dw

■ -numWidgets/nw

Flags removed:

■ -filters/f

manipOptions

Flags added:

■ -rememberActiveHandle/rah
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manipRotateContext

Flags added:

■ -useManipPivot/ump

manipScaleContext

Flags added:

■ -alignAlong/aa

■ -mode/m

■ -orientAxes/oa

■ -orientTowards/ot

■ -useManipPivot/ump

menu

Flags added:

■ -fullPathName/fpn

modelEditor

Flags added:

■ -cameraSet/cst

■ -ignorePanZoom/ipz

■ -modelPanel/mp

■ -viewType/vt

nParticle

Flags changed:

■ -dynamicAttrList/dal no longer takes an argument
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namespace

Flags added:

■ -query/q

■ -recurse/r

■ -relativeNames/rel

■ -rename/ren

namespaceInfo

Flags added:

■ -recurse/r

nodeOutliner

Flags added:

■ -showPublished/sp

outlinerEditor

Flags added:

■ -pinPlug/pin

■ -showPinIcons/spi

■ -showUpstreamCurves/suc

■ -unpinPlug/unp

paneLayout

Flags changed:

■ -staticWidthPane/swp

■ -staticHeightPane/shp
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particle

Flags changed:

■ -dynamicAttrList/dal no longer takes an arg

playblast

Flags added:

■ -combineSound/csd

■ -indexFromZero/ifz

■ -quality/qlt

■ -replaceAudioOnly/rao

■ -replaceEndTime/ret

■ -replaceFilename/rf

■ -replaceStartTime/rst

■ -sequenceTime/sqt

■ -useTraxSounds

pluginInfo

Flags changed:

■ -cacheFormat/cf

■ -dragAndDropBehaviour/ddb

■ -dependNode/dn

■ -device/dv

■ -iksolver/ik

■ -translator/t

These flags no longer take any args.
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polyAutoProjection

Flags changed:

■ -pivot/pvt

■ -pivotX/pvx

■ -pivotY/pvy

■ -pivotZ/pvz

These flags all take floats instead of lengths.

polyOptions

Flags added:

■ -displayInvisibleFaces/dif

polySelect

Flags added:

■ -edgeUVLoopOrBorder/euv

polySlideEdge

Flags added:

■ -edgeDirection/ed now takes float instead of length

polySplitEdge

Flags added:

■ -operation/op

preloadRefEd

Flags changed:

■ -selectFileNode/sf no longer takes an arg
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promptDialog

Flags added:

■ -style/st now takes a string rather than an int

radioButton

Flags changed:

■ -align flag is now ignored

referenceEdit

Flags changed:

■ -editCommand/ed and -onReferenceNode/orn are now multi-use

referenceQuery

Flags added:

■ -child/ch

■ -isExportEdits/iee

■ -isLoaded/il

■ -liveEdits/le

Flags changed:

■ -editCommand/ec and -onReferenceNode/orn are now multi-use

refresh

Flags added:

■ -suspend/su

renderWindowEditor

Flags added:

■ -colorManage/com
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scale

Flags added:

■ -localSpace/ls

■ -orientAxes/oa

■ -objectSpace/os

■ -worldSpace/ws

scriptNode

Flags added:

■ -sourceType/stp

select

Flags added:

■ -containerCentric/cc

selectPref

Flags added:

■ -autoSelectContainer/asc

separator

Flags changed:

■ -style flag now has valid values of "none", "single", "in" and "out" (double, doubleDash
just creates single dash).

skinCluster

Flags added:

■ -addToSelection/ats

■ -forceNormalizeWeights/fnw

■ -normalizeWeights/nw

■ -removeFromSelection/rfs
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■ -selectInfluenceVerts/siv

■ -skinMethod/sm

■ -volumeBind/vb

■ -volumeType/vt

skinPercent

Flags added:

■ -zeroRemainingInfluences/zri

■ -transformMoveWeights/tmw

sound

Flags added:

■ -mute/m

■ -sourceEnd/se

■ -sourceStart/ss

stereoCameraView

Flags added:

■ -ignorePanZoom/ipz

■ -modelPanel/mp

■ -stereoDrawMode/sdm

■ -viewType/vt

Flags removed:

■ -stereoCmd/sc

■ -stereoCmdDefault/scd

 | 79

../Commands/skinPercent.html
../Commands/sound.html
../Commands/stereoCameraView.html


stereoRigManager

Flags added:

■ -cameraSetFunc/csf

surface

Flags changed:

■ -degreeU/du and -degreeV/dv now take ints instead of floats

tabLayout

Controls now have scroll buttons on all platforms if there is not enough space to display
all the tabs. There is a right-mouse button menu attached to each button, listing all the tabs
and making it possible to quickly select any tab.

text

Flags added:

■ -wordWrap/w

textureWindow

Flags added:

■ -drawSubRegions/dsr

timer

The old command has been completely replaced with a new one with different flags.

transferAttributes

Flags added:

■ -matchChoice/mch

translator

Flags added:

■ -loaded/ld

80 | Chapter 13   What's New in MEL and Python

../Commands/stereoRigManager.html
../Commands/surface.html
../Commands/tabLayout.html
../Commands/text.html
../Commands/textureWindow.html
../Commands/timer.html
../Commands/transferAttributes.html
../Commands/translator.html


treeView

Flags added:

■ -allowHiddenParents/ahp

■ -enableKeys/enk

■ -itemSelected/isl

■ -showItem/shi

Flags removed:

■ -drawSelectionBackground

Flags changed:

■ -borderHighlite/bh, -expandItem/ei, -highlite/hl, -itemVisible/iv, -reverseTreeOrder/rto
and -selectItem/si now take booleans instead of floats or ints;

■ -children/ch, -itemIndex/idx, -itemExists/iex, -isItemExpanded/iie, -isLeaf/il and
-itempParent/ip are all now query-only.

warning

Flags added:

■ -showLineNumber/sl

window

Flags changed:

■ -minimizeCommand and -restoreCommand flags are now respected on all platforms

■ -interactivePlacement flag is now ignored.

windowPref

Flags added:

■ -restoreMainWindowState/rms

■ -saveMainWindowState/sms

 | 81

../Commands/treeView.html
../Commands/warning.html
../Commands/window.html
../Commands/windowPref.html


Flags changed:

■ -parentMain/pm takes a boolean rather than an int
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What's New In
Documentation

Improved Navigation Bar

The navigation bar in the Maya Documentation now
remains at the top of your browser window as you
scroll down, letting you easily access the navigation
controls as you browse.

Improved Search

The search field of the Maya Help now supports
phrasal search. You can search for a precise combina-
tion of words by changing the Search method to
phrase.
For more information, see Maya Help in the Basics
guide.

New and updated Tutorials and Advanced Tutorials

You can now find a number of new and updated tu-
torials in the documentation. These tutorials are de-
signed to introduce users to some of the uses and
workflows of the more recent features introduced in
Maya.
A new Advanced Techniques tutorial for nParticles is
now available from the Autodesk Maya Services &Support
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section of the Autodesk website. This tutorial is de-
signed for intermediate and advanced users and con-
centrates on specific, complex topics, and techniques.
■ File Referencing in the Basics guide.

■ Maya Advanced Techniques

List of recommended mental ray shaders added

A list of recommended mental ray for Maya shaders,
for example the mia_material_x shader, have been
added to the Shading Nodes chapter of the Shading
guide.
■ Recommended mental ray for Maya shaders

PyMEL Documentation

The Maya documentation now includes PyMEL tech-
nical reference documentation.

Working with Qt chapter added to API Guide

The API Guide now includes a chapter on how to work
with Qt to create Maya UI.
■ Working with Qt
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What's New in API

New or updated API classes

M3dView

■ The MWindow and M3dWindow types have been merged into a single MNativeWindowHdl
type. The applicationShell and window methods both return this new type.

■ A widget method has been added to return the QWidget associated with the view.

■ setObjectDisplay and objectDisplay methods added to set and query the types of objects
displayed in the view.

■ DisplayObject enumeration expanded to include more types of objects.

■ A Mac64 version of the display method has been added which returns a void pointer to
an NSOpenGLContext.

■ beginXorDrawing and endXorDrawing methods added to provide non-destructive line
drawing which doesn't require hardware overlays, for things such as selection marquees.

■ usingDefaultMaterial method added to quickly determine if the view's Use default material
setting is enabled.

■ Methods added to support multiple draw passes:

■ multipleDrawEnabled

■ setMultipleDrawEnable

■ multipleDrawPassCount

■ setMultipleDrawPassCount

■ beginProjMatrixOverride and endProjMatrixOverride methods added to override a view's
projection matrix.
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■ updateViewingParameters method added to force changes to the camera's projection
and viewing matrices to be applied to the view.

■ ColorIndex mode is no longer supported so the isColorIndexMode method has been
removed.

MCameraSetMessage

■ This is a new class for registering callbacks for cameraSet messages.

MDrawInfo

■ The setMultiPath method has been added to allow setting of the DAG path of the object
to be drawn.

MDrawRequestQueue

■ Copy constructors have been added to allow copies of request queues to be made.

MEvent

■ The calling signatures of the setPosition and setModifiers methods have been fixed to
make them accessible from Python.

MFileIO

■ getReferences method given an optional wantUnresolvedNames parameter to control
whether the returned filenames should be prior to path resolution or after.

■ getFiles method added to return the names of all files in the scene. Parameters can be
used to control whether only references are returned and whether resolved or unresolved
names are returned.

■ Second version of getReferenceNodes added to return the nodes in an MSelectionList.

MFnCamera

■ The following methods have been added to support pan and zoom:

■ panZoomEnabled

■ setPanZoomEnabled

■ renderPanZoom
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■ setRenderPanZoom

■ horizontalPan

■ setHorizontalPan

■ verticalPan

■ setVerticalPan

■ zoom

■ setZoom

■ The getFilmFrustum, getViewParameters and getViewingFrustum methods have all
acquired an optional applyPanZoom parameter to control whether pan and zoom should
be applied.

MFnCameraSet

■ This is a new class to create and modify camera sets.

MFnContainerNode

The following methods have been added:

■ getPublishedNames

■ getRootTransform

■ getPublishedNodes

MFnDagNode

The following methods have been made const:

■ getPath

■ getAllPaths

■ fullPathName

■ partialPathName
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MFnDependencyNode

■ kGlobalDynamicAttr has been removed from the MAttrClass enum since its functionality
was never implemented.

MFnDirectionalLight

■ useLightPosition and setUseLightPosition methods have been added to control whether
objects positioned behind the light should cast shadows.

MFnMesh

■ setInvisibleFaces and getInvisibleFaces methods added to set and query the visibility of
individual faces (for example, as per the polyHole command).

MFnNIdData

■ New class for passing Nucleus id data along connections between nodes.

MFnNObjectData

■ Support added for MnRigid and MnParticle objects.

MFnNonExtendedLight

■ More methods added for controlling depth maps:

■ depthMapFocus

■ setDepthMapFocus

■ useDepthMapAutoFocus

■ setUseDepthMapAutoFocus

■ depthMapWidthFocus

■ setDepthMapWidthFocus

MFnParticleSystem

■ setCount method added

MFnSet

■ The getMembers method now clears the selection list passed to it before adding members.
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MFnSkinCluster

■ setBlendWeights and getBlendWeights methods added to set and query the skinCluster's
blend weight array, which is used to blend between classical linear skinning and dual
quaternion bases skinning on a per-vertex basis.

■ A version of getWeights has been added which only retrieves weights for a specified
subset of the deformer's influences.

MItDependencyGraph

■ setTraversalOverWorldSpaceDependents and isTraversingOverWorldSpaceDependents
methods added to support world-space attribute dependencies in the traversal.

MGeometryPrimitive

■ A copy constructor has been added.

MGeometryRequirements

■ addFaceOffsets method added to request that face offset information be included as a
required element.

MMaterial

■ A new constructor has been added which takes a shader set's MObject. This allows you
to instantiate MMaterials for individual components such as faces.

■ defaultMaterial method added to return the default material. This is the material used
to shade scene objects when the view's Use default material setting is enabled.

MMeshSmoothOptions

■ setBoundaryRule and boundaryRule methods added to control how boundary edges and
vertices are creased.

MNamespace

■ This is a new class to create and modify namespaces.

MNativeWindowHdl

■ New type definition to represent a native window handle on all platforms. This replaces
M3dView::MWindow and M3dView::M3dWindow.
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MnCloth

■ The following methods have been added to provide more information about the
simulation:

■ getThickness

■ getInverseMass

■ getBounce

■ getFriction

MnObject

■ This new class is the base class for all Nucleus objects, such as MnCloth and MnRigid.

MnParticle

■ This is a new class to create and modify Nucleus particle objects.

MnRigid

■ This is a new class to create and modify Nucleus rigid objects.

MnSolver

■ This is a new class to create and modify Nucleus solvers.

MPlug

■ isSource and isDestination convenience methods added. It is no longer necessary to
fiddle with connectedTo just to find out if you have any incoming connections.

MPx3dModelView

■ The following methods have been added to provide support for camera sets:

■ setCameraSet

■ getCameraSet

■ setCurrentCameraSetCamera
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■ getCurrentCameraSetCamera

■ ColorIndex mode is no longer supported so the setColorIndexMode and
isColorIndexMode methods have been removed.

■ The set parameter of the setViewSelectedSet method has been made const.

MPxCacheFormat

■ writeIntArray and readIntArray methods added.

MPxCameraSet

■ This is a new class for creating user-defined cameraSet nodes.

MPxDeformerNode

■ setDeformationDetails and getDeformationDetails methods added to control which
additional components (currently just UVs and colors) the deformer will deform.

MPxFileTranslator

■ allowMultipleFileOptimization virtual method added to allow translators to specify
whether they are compatible with optimizations performed by Maya when the same file
is referenced multiple times.

MPxNode

■ _setDoNotWrite and _doNotWrite methods added to provide Python with access to the
corresponding protected C++ methods.

MPxSurfaceShapeUI

■ surfaceShapeUI static method added to allow retrieval of a custom surface shape's
MPxSurfaceShapeUI from its DAG path.

MPxTransform

■ treatAsTransform virtual method added to allow custom transform nodes to specify
whether they want to be treated like normal transforms nodes or not. For example,
normal transforms are not included in a viewFit operation, but joints, which are derived
from transform nodes, are.
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MQtUtil

■ New class providing methods to work with the Qt controls underlying Maya's UI elements.

MRenderView

■ The updatePixels method has acquired an optional isHdr parameter. When set, this
parameter indicates that the pixel values are in linear CIE XYZ colorspace rather than
the usual standard RGB colorspace.

MSceneMessage

■ To provide finer control over reference handling, the kBeforeReference callback has be
replaced by kBeforeCreateReference, which is only called when a reference is being
created, not every time it is loaded. Similarly, the kAfterReference callback has been
replaced by kAfterCreateReference. The old callbacks will remain available for a couple
more versions of Maya to provide time to transition plug-ins to the new ones.

MSelectionList

■ The add(const MString& matchString) method has acquired an optional
searchChildNamespacesToo parameter.

MString

■ The expandEnvironmentVariablesAndTilde method has been restored to its Maya 2009
functionality, meaning that it no longer performs file-path-specific expansion on the
string passed to it.

■ expandFilePath method added to perform file-path-specific expansions.

MTimerMessage

■ The addTimerCallback method has been fixed so that the callback no longer fires
immediately after set but waits until the specified time period has elapsed.

■ Timer callbacks no longer require Maya to run its idle loop continuously, so the
setSleepCallback and sleepCallbackPtr methods are no longer required and will be
removed in a future version of Maya.

MTransformationMatrix

■ The calling signature of the reorderRotation method has been fixed so that it is now
usable from Python.
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MUiMessage

■ add3dViewPreMultipleDrawPassMsgCallback and
add3dViewPostMultipleDrawPassMsgCallback methods added to set callbacks for the
start and end of each pass when multiple draw passes are enabled. See the
lensDistortionCallback plug-in for an example of their usage.

Example Plugins

■ lensDistortionCallback added to show how to handle multiple draw passes in a normal
model panel (as opposed to a custom MPx3dModelView).

■ cvColorShader updated to work with faces assigned to different shaders. Also made
threadsafe.

■ helixMotifCmd has been replaced with helixQtCmd to reflect the fact that Maya is now
Qt-based. The new plug-in works on all platforms.

■ qtForms added to show how to create Qt UI from within a plug-in, including the use of
forms created in Qt Designer.

■ saveSwatchesCmd added to show how to grab images from controls.
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